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The Pyware™ Instrument Designeris designed to make use of
the ApplellGS ensoniq chip and the Pyware Music Writer. With
the Pyware Instrument Designer and the ApplellGS, you can
create any instrument sound you wish, Alter sound waves,
control sound attacks, sustains, decays, vibratos, pitch bends
and much more. Create anythlng from acoustlc mstruments to
your own ongmal sounds : . : E

The Pyware™ Instrument Des:gner |s also an excell_ent teachmg s

and learning program for teachers and students i in Musw or:

Science. It allows you to both SEE and HEAR how modlflcatlons-:f-}_

to sound waves affect the sound.

Owners of the Pyware™ Music Writer can also benefit from the
Instrument Designer. The Instrument Designer enables youto. - -
create unlimited libraries of sounds that can be used withthe

Music Writerto aid in music composition and notation.

How to use this book @ﬁ

After reading this chapter. Begin leaming about the Instrument
Designer by reading through Chapter 2. This chapter explains
different techniques for modifying sound waves. I is important to
understand these techniques to help you produce the bast
sounds. The remainder of the manual covers each feature. You
can read the features now or refer to the manual as necessary
during a session.

What you need to start ;8'\/0

= Apple IGS with at least 512K

* Instrument Designer Program disk

»  Manual

+  Atleast 2.0 ROM update for ApplellGS
Note: If the first three digits of your computer serial
number are less that 704 then you probably need the
2.0 update. If you do not have the update, the
Instrument Designer will give unpredictable results. Your
local Apple dealer can install this update for you at little or
no charge.

Optional
+  MIDI Interface or MIDI box with a synthesizer
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First back up your disks =%4)

Before you begin, back up your disks. Use any copy program o
copy the program and data disks to blank disks (see note below).
Use the copies and store the originals in a safe place.

Note: Back up your data disk frequently after you begin.-
designing. Although not a common occurrence floppy disks can

Sound Wave Science

Customer Support S5 Q

Pygraphics welcomes the opportunity to talk with you about any: -
matters concerning computers and education. Should you have = -
any need concerning your software, we are ready. if youhave =
any suggestions on software updates, we want to hear them.

Please call us! Our numberis (817) 481-7536.

Hard Disk Users @4)

If you want to use a hard disk with the Instrument Designer, see
the Appendix in the back of this manual.




How

Instrument Designer Works

&

The Instrument Designer uses graphic windows to modify sound
waves. The windows include Vibrato, De-Tuning, Envelope, and
the graph of the actual sound wave. By using these windows you
can dramatically alter the way a sound wave is heard.

Vibrato. With the Vibrato window you can cause the pitch of the
sound to pulsate. A characteristic heard in.many musical sounds.
The vibrato (pulsation) mtenssty as well as the vibrato speed can be
changed. _

De-Tuning. An instrument sound on the instrument designer
actually consists of two sound waves, usually looking exaclly the
same and played exactly at the same time. However, since there

are two distinct waves you can do several unusual things. Youcan |

tune one wave slightly off from the other wave. This causes an
intonation wavering that is commonly heard in instruments.

Envelope. A sound can be dramatically altered by changing the

_ASRD. ASRD refers to the instrument Attack, Sustain, Release

and Decay. The Envelope consists of 8 segments. The slope

between the first and second segment usually indicates the attack.

The slope between the second and third segment usually
indicates the Sustain,
and likewise with the

o Envelope Release and Decay.

BuUStain =

ANACK =

The envelope is the
most significant
window for altering the
way a sound js heard.

For example, a
substantial increase in

2-2

/ \ decay

teloasa segment

the slope of the attack
of a flute will make the
flute sound like a bell.

Sound Wave. The sound wave window is used to draw and edit
a sound wave pattern. You can edit or draw on either wave A or
wave B or both simultanecusly. (Remember, two waves are used
as explained in De-Tuning above)

Sound Design Methods ;%ﬂ

There are usually two ways digitized sounds are used. First, a pure
sound wave played completely through one time, and second,
only a section of a sound wave consisting of the sustained portion
of the wave played repetitively throughout the length of a note.

One Shot Mode

The first type {pure sound wave) takes alot of memory to store the
sound wave. When the wave is played you will hear a very close
approximation to the true sound. Below is a picture of a sound
wave. Notice the different phases of the wave (attack, sustain, and
decay).

not¢ wae released hare
j {release segment)

W

attack Kustain decay

In ONE SHOT MODE an entire wave is played from beginning to
end one time. The wave should contain the three phases shown
above to sound good. The sound waves are usually large in size
(32768 bytes). Sound waves played in one shot mode have the
best quality.

The only draw back to this type of sound wave is that you can only
play the wave through one time for every note, otherwise you
would replay the attack,sustain and decay many times as shown on
the next page.
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attacksustain decay

Repeating a sound wave that contains
an attack sustain and decay as shown here
would make a sound that Iooks Iike thls

Such sound waves are better played in ONE SHOT mode. The
ONE SHOT mode appears in the OPTIONS menu of the program
under Play Mode. The ONE SHOT mode plays the sound wave
only one time through. This is a gocd technique to use for
instruments that do not sustain. For example, a piano has the same
note length regardless of how long you hold down a pianc key,
whereas a trumpet note can be held many times longer. When you
want to hold a note for an instrument such as a trumpet the ONE
SHOT mwode woukl be a poor choice. To sustain a hote for an

instrument like a trumpet, you would need to choose the LOOPED
mode.

Looped Mode

Before we show you the LOOPED technique, lets first diasect the
sound wave used in the previous example. The complete sound
wave was divided into three main parts. The attack, the sustain, and
the decay. And you saw how looping a wave with all three parts
would produce a sound with many repeating attacks, sustains and
decays. However, what if we just picked a single part of the sound
wave, which part would you pick? If the sound wave were a trumpet
and we picked the attack, the sound would be the trumpet players
tongue starting the note with a 1a’ sound. If that part of the wave
was repeated over and over o create a long sound it probably
would not sound like a trumpet player holding the note for a long
time. it would sound more like a trumpet player attacking many
notes over and over very fast.

What if we picked the sustain part of the sound to repeat {lcop)
instead of the attack part. Playing this part of the sound wave over
and over again would sound more like a trumpet player holding a
hote for a long time. This is because the sustain is the part of the
sound wave that you hear when a trumpet player holds a note.

sustain part of
the sound wave

\

sustain postion cut out
$ and looped when played

AN PN

Note: A looping sound wave should be short waves because even
the sustain part of a sound will change through a long sound
sample and when looped will have a quivering sound as it lcops
from the end of the wave back 1o the beginning of the wave. Keep
wave samples under 1024 bytes for best results.
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If we repeat the sustain part of the sound wave over and over there
will not be a real sounding attack io the sound. Therefore the
sound still does not sound like a true trumpet player. This is where
the envelope window is best used. Since we have determined that
the sustain portion of a sound wave is the best part to repeat, we
imust now try to make the sustain part of the wave sound like an
attack when first started. With the envelope we can control the
volume of a sound wave throughout the duration of the sound.
Therefore we can make the attack much louder than the sustain
part of the sound and make the looping wave simulate an attack.

a Envelope

SUSLAIN v

AACK wemt

\ decay

release segment

The Envelope feature is found in the pregram on the Windows
menu.

Notice the above example, there are eight small squares on the
envelope graph. These squares are called handles. The handles
are used to move the graph and change the siope between the
graph segments. As you see, the attack slope is very steep. This
steep envelope will cause a very sharp attack like the sound of a
bell.

Now look at the decay. There are two segments used in this
example for the decay. The first segment has a steeper slope than
the second. This example will first decay to a medium volume fairly
fast and then decay down to nothing more slowly during the last
segment.

The last 4 handles are not used in this example , so they are moved
to the bottom of the envelope window.

Combination of both wave types

There is another technique of sound design that uses both types
of sound waves. This mode is called ONE SHOT A & LOOPED B.
In this technique two different waves are used. The first wave is
Played through one time and then the second wave is repeated
until the note is released.

ONE SHOT A & LOOPED B
Wave A Wave B

NA AT NA N
VAVAVAY YAVAYAY

Wave A is only the Attack part of a sound and Wave B is the sustain
part of the sound. As you see, this eliminates the need for the
envelope to simulate an aftack as used in the previous section.
With this setup only Wave B is used during the sustain. Whereas
the other two techniques use both Wave A and Wave B to contain
the same wave played paralled giving you double the intensity of
the sound.
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The File Menu =%4)

The File Menu contains all of the filing and saving functions of the
program. These fealures are:

New........ Craates a new sound file in memory.

Open....... Reads an existing sound file from a disk and loads
it into memory.

Close....... Removes an existing sound from the computers
memory.

Save........ Writes a sound file that is in the computers
memory back to a disk.

SaveAs..... Wirites a sound that is in the computers memory to
a disk and allows you to enter a new name for the
sound.

Get Wave File.. Reads a Wave File into the Sound Wave window,
keeping the other window settings unchanged.

Librarian . ... Moves a Sound File into a Sound Library. The

Sound Library is a collection of sound files that will
load into the Pyware Music Writer.

Quk......... Leaves the program.

New command =%'ﬂ

The New command creates a new sound file in memory and
displays it on the screen. If there is already a sound file displayed on
the screen the New command will not operate unitil the file has
been Closed. To operate the New command:

1 Move the mouse pointer to the menu item Flle.

2 While hoiding the mouse down, drag the mouse to the New
command on tha Flle menu and release.

3 A new sound file will be displayed on the screen.

Open command =@<0

The Open command loads an exisling sound file into memory
from a disk. If there is already a sound file displayed on the screen
the Open command will not operate until the sound file displayed
is Closed. To operate the Open command:

1 Move the mouse pointer to the menu item Flle.

2 While holding down the mouse button, drag the mouse to the
Open command.

3 An Open dialog box will display:

Opan wrich Sound ie? Disk - changes the disk that is
3 HdzarsoundFlles . "
} Ciiee o] looked at when the list of sound files
O Electric Bass P
O Flute is displayed
o fvl;l";r - Open - opens the file that is
o Clesa 3 N~ highlighted on the list of sound files.
Close - closes the file or folder that is

\ highlighted on
Sound File list the list of sound files.

Cancel - returns to the main screen
without doing anything.

4 Click on the sound file that you want displayed and click the
Open button.
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Close command =%<0

The Close command removes an existing sound file from
computer memory. If there is no sound file displayed, the Close
command will not operate. If there has been a change made on the
sound file displayed, you will be asked if you want to Save the
sound file to a disk before closingit. To operate the Close
command:

1 Mova the mouse peinter to the menu item Close.

2 While holding down the mouse button, drag the mouse to the
Close command.

3 If there have been any changes made to the sound file while it
has been displayed, you will be asked if you want to save the
file before closing.

if you choose YES and the file has not yet been named a save
dialog box will display as shown in the next section.

Save command :54)

The Save command writes a sound file that is in the computers
memory back to the disk. If there is no sound file displayed on the
computer the Save command will not operate. If the file is untitied
you will be prompted to enter a file name belore saving to a disk. To
operate the Save command:

1 Move the mouse pointer to the menu item File.
2 While holding the mouse bution down, drag the mouse to the
Save command on the Flle menu and release.

(continued next page)

3 Ifthe file is untitled a Save dialog box will display.

s ROV / Disk - changes the disk that is
Frea: xxxxk out of xxxxk.m iooked at when the list of files is

a riute - displayed
o] New Folde
Flectric Bass ™~ New folder - creates a new folder

fm] TamToms

O Wierd Copen )|  forthe new sound file
\ FEC] Open - opens a folder
Save documant as:\ C.’“—m Ciose - CIOSGS a folder

5 ———— [~ Save - writes the sound file to the
disk
\ Cancel - returns to the
New file name main screen

List of files and foiders

4 Type the new file name and click the Save button.

Save As command =%<0

The Save As command writes a sound file that is in the computers
memory fo a disk while allowing you to change the name of the
sound file. To operate the Save As command:

1 Move the mouse pointer to the menu item File.

2  While holding the mouse button down, drag the mouse to the
Save As command on the File- menu and release.

3 A save dialog box will display as shown on previous page.

4 Type in the new name for the file and click the Save button.
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Get Wave File =g\ﬂ

" The Get Wave File command is used to load a wave file into the

Sound Wave window. Don't confuse a ‘wave file’ with a' sound file'.
A wave fileis a binary file that only contains a wave table. A sound
fileis a file that contains a wave table and all other information such
as the envelope, vibrato, relative pitch, etc. Sound files are loaded,
saved and created with the Open, New,Save, and Save As
commanis on the File menu. Wave files are created by other
programs such as samplers and can be loaded into the Instrument
Designer via the Get Wave File command. To use the Get
Wave Flle command:

1  Open a sound file whose Envelope, De-Tuning, Vibrato, and
Relative Pitch is something that you want. if you want the
default setlings for these, seleci New from the Flie menu.

2 Select Get Wave File from the File menu.

3 A dialog window will display asking whether you wart this wave
file written to Wave A, Wave B or both Wave A & B.

4 Adialog window will display giving you choices of files that you
may want. After choosing a file, the wave table will be loaded
into wave A and/or wave B.

Librarian -
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The Librarian is used to move sound files into a collection of
sounds called a sound library. Sound Libraries are used with the
Pyware™ Music Writer. if you do not own the Pyware Music Writer
this feature is not of any use. To operate the librarian:

1 Select Librarian from the Flle menu. -
2 A lLibrarian dialog window will display. As shown on the next

page.

Click on an instrument that you want in the library.

Pywars instrument Librarisn

HD20\Saundst Untitted
- -
Clarinet
-
Piano

Bird

g _Dole!a Instrument  }
Trumgpat

/ Ogpen Another Library

Quit

For example the trumpet sound.

3 Click the Install button and a copy of the sound will be written
into the sound library.

4 Repeat steps 2 and 3 until al sounds that you want are in the
library

5 Select Quit and you will be asked whether you want to save
the library file. Choose YES and enter a new sound library file
name.

Other options:

Extract - Moves a sound file out of the sound library (right side) to
the sound files list (left side). To use, click on the soundin the
library {right side) you want extracted, then click Extract.

Delete Instrument - Removes an instrument from the sound
library (right side). To use, click on the sound in the library {right
side) you want deleted, then click Delete Instrument.

Open Another Library - Saves the current library on the right

side (if any) and displays an Open dialog window for you to choose
another library to display.
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Quit command ;%’4)

The Quit command leaves the program. If you have a sound file
that you have made a change on and you have not saved it, you will
be prompted 1o save the file before quitting.

1 Move the mouse pointer to the menu item File.

2 While hoiding the mouse button down, drag the mouse to the
Quit command on the File menu and release.

3 ifthere is a sound file displayed on the screen with changes
that have not been saved, you will be prompted to save the file
before quitting.

Chapter 4

The Edit Menu




TheEditMenu
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you can delete portions of a wave as well as cut, copy and paste
portions of a sound wave using the clipboard. The clibboardis a

temporary memory location that will hold copies of a sound wave for

dupiicating and moving.

Cut........... This function cuts a selected range from the

sound wave in the sound wave window and saves

the cut selection in the clibboard for future use.

Copy......... This function makes a copy of a selected range of

a sound wave in the sound wave window and
saves the copy in the clipboard for future use.

Paste......... This function takes a sound wave that is stored in
the clipboard and inserts it into the sound wave in

the sound wave window at the marked position.

Delete........ This function deletes a selected range from the
sound wave in the sound wave sindow.

The Clipboard

&

The Edit menu is used to edit sound waves. With the Edit menu

&

The clipboardis a memory location that is used to store temporary
copies of a sound wave so that you can relocate the wave at a new
position. For example to copy the attack of WaveA to the
beginning of Wave B you woulkd:

1 Setthe mode on the sound wave window from Draw to
Select.

2 Select wave on the sound wave window to be Wave A.

3 Use the mouse to drag through (or select) the beginning range
of the sound wave. It will become inverted indicating that it is
selected.

4 Choose Copy from the Edit menu. This will make a copy of
the selected range into the clipboard.

5§ Switch to Wave B on the Sound Wave window.

6 Click on the beginning of the sound wave to indicate the
insertion point.

7 Choope Paste from the Edit menu. This will make a copy of
the clipboard into Wave B at the insertion point.

Selecting ranges @

Before you can edit with the clipboard, you must first select the
range on the wave file you want to copy, cut and paste. Selecting
ranges is possible with the Sound Wave window. The picture
below shows steps for selecting a range.

Choose the wave you want to copy, cut, or delet

Choose the Select mode M

| o " Sound Wave “~a

LW AAY._ YWave B Wave ARB mem:

With the mouse, drag from the beginning to the ending
of tha range you want fo selact.
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The steps for selecting ranges are:

1

Choose the sound wave you want by clicking Wave A or
Wave B from the Sound Wave window. You cannot edit
from Wave A and Wave B at the same time, so the Wave
A&B option is not a valid option from the Sound Wave
window for selecting ranges.

Click on the Select buttonon the Sound Wave window to
indicate that you are going to be selecting a range.

With the mouse move to the beginning of the sound wave
range you want to select.

While holding down the mouse, drag the mouse to the end
of the sound wave range you want to select. The selecled
portion will be highlighted. (Note: There are several keys
that are usetull for selecting ranges when your range will not
all fit on the window. These keys are covered next.)

Seiecting Range Shortcut Keys
To select from a chosen point to the END of the wave, hold

down the Command key while clicking on the beginning of the
range with the mouse.

4-4

To select ranges larger than the Sound Wave window.

1
2

3

Select the beginning of the range with the mouse.

Scroli to the wave portion that contains the end of the
selection you want.

Hold down the Shift key while clicking on the ending position
with the mouse.

To select a range from the BEGINNING to a chosen point, hold
down the Shift key while clicking on the ending of the range with
the mouse. .

To EDIT a selected range, hold down the Shift key while clicking
on the new beginning or ending range with the mouse.

Cut command

&

The Cut command removes a selected portion of a sound wave
and places the cut portion in a temporary storage location called
the clipboard. To use the Cut command:

1

Copy command

Choose which wave you want to cut from, and click on the
wave choice in the Sound Wave window. Valid wave choices
are Wave A and Wave B. (lf the Wave button is already
highlighted, you don't have to click it again.)

Click on the Select button in the Sound Wave window.
This will indicate to the program that you want to select a
range from the sound wave. (If the Select button is already
highlighted, you don't have to click on it again.)

Move the mouse to the BEGINNING of the portion of the
sound wave that you want to cut.

While holding down the mouse, drag the mouse to the END
of the portion of the sound wave that you want to cut. {See
Selecting Range Shortcut Keys, earlier in this chapter for
more flexahility in selecting ranges)

Choose Cut from the Edlt menu. The selected range of
the sound wave will be deleted and copied to the temporary

storage location called the clipboard.

The Copy command makes a copy of a selected portion of a
sound wave and places the copy in a temporarty storage location
called the clipboard. To use the Copy command:

1

Choose which wave you want to copy from, and click on the
wave choice in the Sound Wave window. Valid wave choices
are Wave A and Wave B. (I the Wave button is already
highlighted, you don't have to click it again.)

Click on the Select button in the Sound Wave window.
This will indicate 1o the program that you want to select a
range from the sound wave. (If the Select button is already
highlighted, you don't have to click on it again.)

Move the mouse to the BEGINNING of the portion of the
sound wave that you want o copy.
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4 While holding down the mouse, drag the mouse 1o the END

of the portion of the sound wave that you want to copy. (See
Selecting Range Shortcut Keys, earlier in this chapter for
more flexability in selecting ranges)

Choose Copy from the Edit menu. The selected range of
the sound wave will be copied to the temporary storage
location calied the clipboard.

Paste command Fg@

The Paste command moves a copy of the wave selection in the
clipboardinto the sound wave at your chosen position. To place
a wave selection into the clipboard you must first have used Cut
or Copy. To use Paste:

1

Choose which wave you want to cut from, and ¢lick ¢n the
wave choice in the Sound Wave window. Valid wave choices
are Wave A and Wave B. (If the Wave button is already
highlighted, you don't hava to ¢lick it again.)

Click on the Select button in the Sound Wave window.
This will indicate to the program that you want to select a
range from the sound wave. (If the Select buiton is already
highlighted, you don't have to click on it again.)

Move the mouse to the BEGINNING of the portion of the
sound wave that you want the clipboard inseried.

Choose Paste from the EdIt menu. A copy of the clipboard

will be inserted into the poisiton indicated.

Delete command g{)

The Delete command removes a s’elected_'portion of a sound
wave. To use the Delete command:

4-6

1

Choose which wave you want to delete from, and click on the
wave choice in the Sound Wave window. Valid wave choices
are Wave A and Wave B. (If the Wave button is already
highlighted, you don't have to click it again.)

Click on the Select button in the Sound Wave window.
This will indicate 1o the program that you want to select a
range from the sound wave. (If the Select button is already
highlighted, you don't have to click on it again.)

Move the mouse to the BEGINNING of the portion of the
sound wave that you want to delete.

While holding down the mouse, drag the mouse to the END
of the portion of the sound wave that you want to delete.
(See Selecting Range Shorntcut Keys, earlier in this chapter
for more flexability in selecting ranges)

Choose Delete from the Edit menu. The selected range
of the sound wave will be deleted from the sound wave.
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The Windows menu is used to display each of the graphic windows
that are used io modify a sound. The windows inciude:

Sound Wave . . . Displays the actual sound wave. The sound wave
can be edited through this window.

Keyboard . .. Displays a piano keyboard so that the user can test
his sound by selecting different notes from the
keyboard.

Envelope . .. Displays the envelope where the attack, sustain,
release and decay of a sound can be altered. This
will greatly change the way a sound will be heard.

Vibiato....... Displays the vibrato window. This window can
change the speed and depth of a vibrato or
puisation of a sound as it is played.

De-Tuning .. Displays the De-Tuning window. Two copies of a
sound wave are usually played simultaneously
{Wave A & Wave B). This window can change the
pitch of one of the waves in very small increments.

Volume. ..... Displays the Volume window. This window
changes the playing volume of the sound while
you are testing it. There is also a STOP bution
used to stop the sound if you cause an infinite
loop in the envelope.

Sound Wave window s

The Sound Wave window displays the actual soundwave. The
sound wave can be edited through this window.

chooses which wave draw mode  select mode

JAN N

| / \ Sdynd wave Title \ |
waveB] wave A&B | Select

A

\\
ChoosingWave AorB

Sounds onthe Apple IIGS normally use two soundwaves thatare
identical. When both are played simultaneously the AppieliGS has
aricher sound. Using two waves also gives you more flexibility in
what you cando with the sound. For example two differentwaves
played simultaneously give intresting results. You can also make
the pitches of the two waves slightly differentto give the sound
more depth. As shown above, you candisplay wave A, by clicking
the Wave A box found just under the Title line. Clicking Wave B will
show only wave B and clicking Wave A&B will show bothwave A
andB.

wave form area




Drawing on the wave

If you want to edit the shape of a sournc wave, you can do it with the
mouse.- To Draw.

1 Click on the Draw box.

2 Click onthe wave that you want to draw on a pottion of. {Wave
A, Wave B, or Wave A&B)

3 Move the mouse to the stan of the sound wave portion you
want to change.

4 Drag the mouse to draw the new shape of the wave form.

Selecting ranges 1o edlt

If you want to copy portions, delete portions, or move portions of a
wave you will use the Select button to select ranges of the wave
for the edi} operation. To Select:

1 Click on the Select box.
2 Use the mouse 1o drag through the range you want to edit.
3 Choose an edit function from the Edit menu.

More details on editing wavas are found in Chapter 4 - The Edit
meny.

Keyboard Window @4
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The Keyboard window displays a piano keyboard so that the user
can test his sound by selecting different notes from the keyboard.
To use the Keyhoard window:

1 Move the mouse to the note on the keyboard that you want to
play.
2 Hold down the mouse fo play the note.

sustain —

attack

Envelope Window =%’\0

The Envelope window dispiays the envelope where the attack,
sustain, release and decay of a sound can be altered. This will
greatly change the way a sound will be heard.

a Envelope
o

/l
/ \ decay

release segment

The small boxes found in the window are called handles. These
handles are used to move the envelope slope lines. The example
above has a strong attack, the sustain is the part of the envelope
that is horizontal (no slope). The release segment is the point in
the envelope that is jumped 1o when you release the note onthe
keyboard. Afterthe note is released, it decays quickly and then
slows down until the sound is gone. As shown, the decay is in two
segments. The first with a fast slope and the second a slightly
slower slope. '

Infinite loops or Susfaln loops: When you release your note on
the keyboard the the sound will jump to the part of the envelope

that is called the release segment. If there is a segment after that
point that has no slope (horizontal) the sound will stick at that point.
This is called an infinite loop. You rarely want this but since
someone might want a sound to do this we have made it possible. If
your sounds stick in an infinite loop and you want them to stop,
there is a STOP button provided in the volume window. Just click
on the STOP button and the sound will quit.
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Lowest position you can move a handle: If you place a segment

handle at the bottom of the window the sound will stop at the end of
that segment regardless of any other segments positions past that
point. This is why you cannot move a hardie to the bottom of the
envelope untill all segment handles past that point are at the
bottom also. To get around this, simply move handles to the
bottom of the window starting with the LAST handle in the

Envelope Examples
The next few pages contain several Envelope Window examples.

It is recommended that you review these examples to fully
understand the envelope and how to make setting adjustments.

Example Envelope #1

sharp |~ fast drop off after attack

attack -4-

sustaining part of sound
(horizontal lines always sustain)

— moderate decay

after note is released

\ release segment

Notice the sustaining part of the sound. This is called the
‘sustain loop". Itis created by placing twa handles that are
next to each other at the same horizontal level (volume).
This is the part of the wave where the sound volume
STICKS. When you release the note the sound volume
wili continue to the part of the envelope that is called the
‘release segment’. As you see the release segment is
AFTER the sustain loop. The sound volume will now trave!
through the remainder of the envelope through the part that
is labeled 'moderate decay".

mild

attack

Example Envelope #2

practically no drop off after attack

sustaining part of sound
{horizontal lines always sustain)

o {ONY dECAY
s, after note is released

\ release segment

sharp
attack

Example Envelope #3

]

fast drop off after attack

slow decay
after note is releaded

release segment

NOTE: Unlike examples 1 & 2, there are no sustaining
segments (sustain loops) to the wave. Sustain loops
are made by putting two adjacent handles together at
same vertical level (volume). This exampie will not
sustain. Non-sustaining envelopes are good for
instruments such as guitars, pianos and bells because
these instruments are unable to sustain for long times.

The release segment is at the end of the envelope. This
is when a note is released the sound volume will jump

directly to that part of the envelope.
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Example Envelope #4

sharp
attack

drop off after attack

sustain
loop

'
release segment

After the note is attacked and the volume begins dropping
off it will STICK at the sustain loop. The sustain loop will
hold the note. When the note Is released, the sound
volume will jump back to the release segment point of the
envelope and play back to the STICK point again. This
note, therefore, will never stop unless you press the STOP
button on the Volume window.

5-8

sharp
attack

This example is exactly the same as example #4, except

Example Envelope #5

o]
X

/ ‘

drop off after attack

sustain loop

/
release segment

the release segment has been moved. The release
segment is now AFTER the sustain loop. The sustain loop

is the horizontal part of the envelope. Now as the sound
volume follows the envelope graph, the sound volume

STICK at the sustain loop, causing the sustained part of the
note. When the note is released the sound volume will set
to the release segment point of the envelope and continue
down the decay until the sound volume is 0.
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Example Envelope #6 ~ Vibrato window @)
|

sharp The vibrato window can change the speed and depth of a vibrato or
attack pulsation of a sound as it is played.
B Vibrato
\ control
_‘ handle
release \ A [ i
segment _ V
| : it mirire—-
vibralo
spoed

5-10

/ i

sustain loop this shaded portion will not play The control handle is used to change the vibrato. Moving the

= handle UP will increase the depth of the vibrato. Moving the handle
The shaded portion of this envelope will NEVER play left will decrease the speed of the vibrato (pulsation).
because of the location of the sustain loop and release
segment. The sound volume will follow the envelope to the
sustain loop where it will stick creating the sustain portion
of the note. When the note is released the sound volume -
will jump to the release segment and follow the remainder . .
of the envelope to the end. Therefore, the shaded portion De-Tunmg WIndOW _;@)
of the envelope will never be played. e

Two copies of a sound wave are usually played simultaneously.
This window can change the pitch of waves in very smali
increments. This causes a slight inlonation waver that is commonly
heard in some instruments.

[=] Do-"l-'unlng

[1/2 Btep shap

Q{'?:] in-tune
handles

The handies are used to change the pitch of one of the two waves.
Wave Ais onthe left and Wave B is on the right. As you drag the
handle up the pitch raises up to 1/2 step from the original pitch.
When the handle is at the bottom, the pitch is set to correct pitch.

LEiLELL




Volume Window =%4)
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The volume window is used to change the volume of the keyboard
when you test sounds. There is also a STOP button to stop a
sound that is infinitely playing due to an envelope segment set with
no slope. (sustaining pitch)

[u} Volume stop
louder sound
/ button

YA

Volume: Use the volume handle to adjust the volume. Moving it up
will increase the volume and moving it down will decrease the
volume.

no sound

Stop button: If you should create an envelope that has an infinite
loop (see Envelope Window). Clicking on this button will stop any
infinite sounds.

Chapter 6

The Envelope Menu
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The Envelope Menu :%\’O Revert To Snapshot _%’4)

This option is used in conjunction with Snapshot Envelope.
The Enveiope menu contains features used to modify the See Snapshot Envelope above. To use this command simply _
Envelope Window. select it when you want the envelope reverted back to the
snapshot envelope.

Snapshot Envelope . ... Takes a picture or snapshot of the
current Envelope window.

Revert to Snapshot . ... Replaces the current Envelope
window with the window that is in the -~ Exchange Snapshot ___go
snapshot. ! -
This option operates like Revert to Snapshot except the
Exchange Envelope .. .. Switches the envelope that is current Envelope window settings are exchanged with the
currently displayed in the Envelope o Envelope Snapshot. The Snapshot values will then be displayed

window with the envelope that is in
the snapshot.

on the Envelope window and the Seitings in the Envelope window
will be placed in the snapshot.

For more information about the envelope, see Envelope
Window in Chapter 5.

This is handy if you take a snapshot of an envelope setting you like,
then you experiment with the envelope. After experimenting you
want to hear which envelope you like best. You can exchange the
two envelopes back and forth and hear each of them to choose
which one'is best.

SnapShot Envelope ,%\'0

This options takes a picture or snapshot of the current Envelope
window. This is useful if you like the way an envelope is set but you
want to experiment with a few changes. If your changes are not as
goed as the envelope snapshot, you can revert back {o the
snapshot. This way you don't have to try to re-make a envelope
setting you liked if you experiment with new settings. To use this
command simply select it anytime you want a snapshot made of the
envelope. : :
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Chapter 7

The Options Menu




The Options Menu @4)

7-2

The Optlons menu contains the following:

100% Wave . . Displays a sound wave in 100% mode. This
means that each pixel across the screenis one
data byte.

Size To Fit . . . Displays a sound wave in Size To Fix mode. This
imeans that the entire wave, regardless of its size is
compressed 1o fit within the width of the sound
wave window.

WaveSlze . .. Changes the storage size of the sound wave.
You can change the size of Wave A and Wave B
independently.

Relative Pitch . Changes the pitch played when a key is pressed
on the keyboard. Shiits all notes up or down the
amount chosen. Increments are in 1/2 steps.

Play Mode . . . Changes the method (or mode) in which the
sound waves are played.

100% Wave & Size To Fit options =®O

These options change the way in which a wave is displayed on the
Sound Wave window. If you choose 100% Wave, the wave will
draw on the window where each pixel (screen column) represents
1 byte in the wave. If you choose Size To FRt, the wave will be
drawn compressed so that the entire wave will it within the border
of the Sound Wave window.

Wave Size option @4)

The Wave Size option is used to change the length of the wave
sample in the Sound Wave window. You can change the length of
the two waves Wave A and Wave B independently.

Note: Indepentent wave size control is useful when you are using
a Play Mode called ONE SHOT A & LOOPED B. in this mode the
first mode is played one time through first {the attack of the wave)
and the second wave is looped to play the sustaining part of the

~ sound. Your choices are from 256 bytes to 32k. The largerthe

wave the better the quality of sound. The smaller the wave the
more that will fit into a sound library. See the chapter on Sound
Wave Science to help you determine the correct sound wave size
to choose.

Wave A Wave B

© 256 byes @ 256 bytes
O 512 bytes @ 612 bytas
Q 1024 bytes O 1024 byles
O 2048 bytes © 2048 bytes
O 4086 bytes @ 4086 byles
O a192 bytes  © 8192 bytes
© 16384 bytes © 18384 bytes
O 32768 bytes © 32768 bytes

To select a sound wave size click on the desired button and click
QK.
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Relative Pitch option >%4)
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The Relative Pitch options is used to change the note played
when a note is pressed on the keyboard. A Sound wave is
recorded at a certain pitch. This pitch is called the true pitch of the
sound wave. This feature will adjust the true pitch so that all notes
are offset by the value indicated.

Relative Pitch
Wave A Wave B

Octave 4 Octave 4
Note 1%

There are two slide scales on the Relative Pitch window, one for
wave A and one forwave B. You can adjust the relative pitch of the
waves independently with these slide scales.

If you move the slide up, the note offset will go up theretore playing
higher notes. if you move the slide down, the note offset will go
down therefore playing lower notes.

If the offset indicators located above the slide are positive numbers
the offset is above the true pitch of the sound. If the offset
indicators are negative numbers the offset is below the true pitch
of the sound.

Play Mode option . g@

The Play Mode oplions change the way the sound waves are
played. There are three methods: Looped A&B, One Shot
A&B, One Shot A & Looped B. As discussed before there
are actually two waves per sound. Usually the two waves are
identical and played simultaneously. However, with these three
modes you have several other options.

Looped A&B mode plays both waves A and B at the same time
and when the wave is played through one time (usually taking only
fractions of a second) the computer ioops back and plays it over
again. This will allow you to use a shont sound wave and yet it can
sustain a long time for long notes.

WlVG’A‘AAA
AWAWAW(N
HV VWV

Wave B

One Shot A&B mode plays both waves A and B at the same time
but plays it only one time. This method is good for very long sound
waves (i.e. wave size of 32768 bytes). The quality of the sound is
usually greatly improved with long waves, however, they usually
are too long to loop using LOOPED A&B method. Therefore,
choosing ONE SHOT will provide a good quality sound but it can
not be sustained for long notes.

ONE SHOT AL B
Wave A

P
TN
YRVRVAY;

Wave B
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One Shot A and Looped B provides a unique technique for

playing two sound waves. The attack of a sound wave is usually
very different than the sustaining and decaying portion of the
sound. If you want to loop a sound wave with such an attack you will
end up replaying the attack part of the sound many times while the
sound is being held for long notes. The One Shot A & Looped
B mode gets around this problem. If you put only the attack part of
the wave in Wave A and put only the sustain part of the wave in
Wave B this mode will work well. Wave A will only play one time,
therefore playing the attack part of the sound, then Wave B will loop
until you release the note thus playing the sustain part of the note.

\OA N AN AT
VRVAVAY YRVAVAY

In the figure above the aftack is Wave A and the sustain part of the
sound is stored in Wave B.

Play Mods

e Locped A & B
O oesnotAsB

© (0ne Shot A & Looped B

C=D

To change the Play Mode click on the desired mode and click
OK. '

Chapter 8

The Sampler Menu
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The Sampler Menu =%‘4)

The Sampler menu contains commands that use a digitizer card

Record =g\ﬂ

The Record command is used to read sound samples from a

such as MD Ideas Stereo Card with Digitizer. There is only one digitizer card such as MD Ideas Stereo Card with Digitizer. Sounds
Sampler command. o are played into a microphone and turned into digital values and
f stored on the Instrument Designer as a wave on the Wave Sound
Record Reads the digitizer card and stores the result - window.
(sample) in memory as Wave A, Wave B or both
Wave A & Wave B. The Sampler menu has only one menu item. it is called Record.

The Record command Is used to record or read a sound as it is
played into the microphone. To use Record:

1 Select Record from the Sampler menu.

2 Adialog will display that indicates which wave the sample will be
writtento. Your choices are Wave A, Wave B or Wave A&B.

3 A Recording dialog box will display:

Digitizer Slot = 1

Samples per second = 27.5

C Siart ) ( Cancel )

From the box you should setup the following things:

« Digitizer Slot - Indicates the slot in which the digitizer
card is located.

« Sample Rate - Indicates the number of data points read
per second. The higher the number of data points the
more accurate the reading. The lower the data points the
longer the sample.

To change any of the above settings, simply click on the
number to the right of the equal sign (=). Every time you click
on a number it will change to the next valid value.
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3 To begin recording click on the Start button. Once clicked
you will have only a few seconds to record the sound.

The digitized sound will be recorded and written to the
Sound Wave window.

4 Unless you began your sound exactly when you clicked the

Start button (which is very unlikely), you wili need to Cut the
silent portion of the recording found at the beginning of the

sound wave. : 7'
/— Rocording staned hare : This is one cycle of the sound wave.

Actual sound bagan here

Sound waves are only stored in memory in sizes that are multiples
of 256 bytes. if you want fo create a short wave that is 256 bytes.
Try the following:

Set the Wave Size to 1024 byles.

Record the sound.

Display wave in 100% mode.

Find one good wave cycle and crop all but that cycle.

if the wave cycle is longer that 256 bytes, re-sample with a
higher trequency. If the wave cycle is shorter than 256 bytes,
re-sample using a lower frequenycy.

6 Setthe Wave Size to 256 bytes.

bW -

\— CROP this portion of the sample
_-_ if you want o create a sound that has no sustain such as guitar,

The Cut feature is found on the Edit menu. (Refer to Chapter : piano, bells, etc. you will probably use ONE SHOT A&B mode.

4 - Edit Menu for details) | With this mode you should take as long a sample as possible.
Recording Hints Set the Wave Size to 32768 bytes.
Record the sound.
Display wave in 100% mode.
Cut the dead space from the beginning of the sound. (This is
the recorded part before the sound began.)

Priorto recording a sound you should decide what play mode you
will be using. If you use a LOOPED ASB mode, you should plan on
using a shor wave. Usually you will want a sample that has only one
cycleinit.
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MIDI Troubleshooting ‘ =%“\ﬂ Installing Instrument Designer _@ﬂ
° onhard disk ‘

If your MIDI record or play is not operating check the following:

The version of PRODOS and Apple system tools installed on your

RAM must be free and not used as RAM Disk. This hard disk may be different version from those that the Instrument

information is found on your AppleliGS Control Panel. (See Designer can work with. You may need to copy ProDos and Apple

ApplellGS Owner's Guide) system too{s found on the Instrument Des:gnerprogram.dlsk to .

your hard disk. if this prevents other programs from working you will

' have to recopy the current versions back to the disk when you want
1o run those programs.

* Your computer must have at least 512K Free RAM. The

- Slot 7 of the computer must be set to Your Card. This
information is also found on the ApplellGS Control Panel.

1 Aiter starling the ApplellGS finder, insert the Instrument

« [f you are using a MIDI interface card that plugs into a slot
y g pua Designer into the disk drive.

inside the computer, use slot 2, and set Slot 2 on the

i8llGS Control Panelto Your Card.
App 2 Drag the following/nstrument Designer document

« if you are using a Casio HT700 synthesizer, you must always INSDESIGNER.SYS16 to the hard disk icon:

select one of the program buttons {piano, harpsichord, etc.)

before each transmission when using the Apple MIDI Box. 3 Onthe hard disk, rename InsDeslgner.SYS16 to

INSDESIGNER.

*  Your ApplellGS must have the 2.0 ROM. If the first 3 digits of
your serial number are less than 704 the you probably need
the 2.0 update. Your local Apple dealer ¢an install this
update for you at little or no charge.
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Making Data Disks

&

To make a data disk for the sound files created by the Instrument
Designer:

1

2

Appendix-4

insert the AppleliGS Systern Disk and turn on the computer.
Double-click on SYS.UTILS folder.

Double-click on SYSUTIL.SYSTEM application.

Select Format a Disk.

Remove the Apple HIGS Systern Disk from the disk drive.
Insert a blank or scraich disk into the disk drive.

Select the slot and drive of the disk you want to format.

The first 3.5" drive is usually slot 5 drive 1.

The second 3.5" drive is usually slot 5 drive 2.

The first 5.25" drive is usually skot 6 drive 1.

Select ProDos operating system.

Enter DATA for the volume name (the delete key will back up)
and press return.
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